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Introduction
Use this manual to upgrade to Business Portal for Microsoft Dynamics® GP 2010 
(internal version number 5.0). You can upgrade from the following Business Portal 
releases:

• Business Portal 3.0 
• Business Portal 3.0 with Service Pack 1
• Business Portal 4.0 
• Business Portal 4.0 with Service Pack 2

You must upgrade to Microsoft Dynamics GP 2010 before you can upgrade Business 
Portal. Business Portal 5.0 is supported only on 32-bit versions of Windows and 
SharePoint.

Check for updated instructions
This information was current as of December 1, 2010. The documentation may be 
updated as new information becomes available. Check the Microsoft Dynamics GP 
documentation web site (http://go.microsoft.com/fwlink/?LinkId=163279) for the 
most current documentation. 

This introduction is divided into the following sections:

• What’s in this manual
• Symbols and conventions
• Additional resources
• Technical support
• Send us your documentation comments

What’s in this manual

This manual provides step-by-step instructions for upgrading and configuring 
Business Portal. It includes the following chapters:

• Chapter 1, “Upgrade overview,” provides an overview of the upgrade process.

• Chapter 2, “Before you upgrade,” explains steps you should take to prepare for 
the Business Portal upgrade.

• Chapter 3, “Upgrade SharePoint,” describes the procedure for upgrading 
Windows SharePoint® Services. You must upgrade Windows SharePoint 
Services before you upgrade Business Portal.

• Chapter 4, “Upgrading from Business Portal 3.0,” describes the procedure for 
upgrading Business Portal. You also can migrate customizations made in the 
previous release of Business Portal, if necessary.

• Chapter 6, “After you upgrade,” explains steps you may need to take after 
upgrading Business Portal.

http://go.microsoft.com/fwlink/?LinkId=163279
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Symbols and conventions

This manual uses the following symbols to make specific types of information stand 
out.

This manual uses the following conventions to refer to sections, navigation, and 
other information.

Additional resources

In addition to this manual, the following documentation is included with this 
release of Business Portal.

Manuals
The following PDF manuals are included in the Documentation folder on the 
Business Portal installation media.

After you’ve upgraded Business Portal, you can find links to these manuals and 
other printable Business Portal documentation in the Documentation Resources 
web part on the Administration Resources page. (On the top-level Business Portal 
site, click Administration.)

Business Portal Installation Guide The Installation Guide 
(BusinessPortalInstallation.pdf) provides step-by-step instructions for installing 
Business Portal.

Business Portal Administrator’s Guide The Administrator’s Guide 
(BusinessPortalAdminGuide.pdf) explains how to set up and configure Business 
Portal.

Symbol Description

The light bulb symbol indicates helpful tips, shortcuts, and suggestions. 

The warning symbol indicates situations you should be especially aware 
of when completing tasks. Typically, this includes cautions about 
performing steps in their proper order, or important reminders about 
how other information in Business Portal or Microsoft Dynamics GP may 
be affected.

Convention Description

Upgrade Business 
Portal

Italicized type indicates the name of a section or procedure.

File > Print The (>) symbol indicates a sequence of actions, such as choosing items 
from a menu, toolbar, or palette. This example directs you to go to the 
File menu and click Print.

Bold Bold type indicates navigation, tab names, menus, commands, buttons, 
field names, keywords, and functions.

Business Data Catalog 
is available only if 
you’re using Business 
Portal with Office 
SharePoint Server 
2007, Enterprise 
Edition

Margin notes indicate when a topic applies only if you’re using a specific 
product or technology.
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Business Portal User’s Guide The User’s Guide 
(BusinessPortalUsersGuide.pdf) helps users complete day-to-day tasks in Business 
Portal.

Application manuals User and Administrator manuals for each application 
installed in Business Portal are available in the Documentation folder.

Help
Help is available by clicking the Help icon button, located in the upper-right corner 
of any page. The help that is displayed depends on whether you open help from a 
Business Portal page or a SharePoint page.

Business Portal help When you click the Help icon button on a Business Portal 
page, the relevant help topic for that page is displayed. You can use the search field 
on the help page to search for information. You also can click the Home icon button 
to browse the contents of the help.

Windows SharePoint Services help  Many of the features included in 
Business Portal—such as document libraries, lists, announcements, links, and 
alerts—are provided by Windows SharePoint Services. General information about 
these features is provided in the Administering Business Portal help. For more 
detailed information, refer to the Windows SharePoint Services help, which can be 
accessed by clicking the Help icon button in the upper-right corner of any Windows 
SharePoint Services page. If you’re using Office SharePoint Server 2007 or Microsoft 
SharePoint Server 2010, additional help related to the SharePoint Server features 
also will be available.

Technical support

You can contact Microsoft Dynamics GP Technical Support online or by telephone. 
Go to www.microsoft.com/dynamics and click the CustomerSource link or call 888-
477-7877 (in the U.S. and Canada) or 701-281-0555.

Send us your documentation comments

We welcome comments regarding the usefulness of the Microsoft Dynamics GP 
documentation. If you have specific suggestions or find any errors in this manual, 
send your comments by e-mail to the following address: bizdoc@microsoft.com.

Note: By offering any suggestions to Microsoft, you give Microsoft full permission to use 
them freely.

http://www.microsoft.com/dynamics
mailto:bizdoc@microsoft.com
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Chapter 1: Upgrade overview
This chapter contains an overview of the Business Portal upgrade process. You can 
upgrade from the following releases:

For an overview of the new features in Business Portal, refer to the What’s New 
documentation, available in the Documentation folder on the Business Portal installation 
media.

This information is divided into the following sections:

• Upgrade process
• Checklist 1: Business Portal 3.0 on Windows SharePoint Services 2.0 to Business Portal 

5.0 on Windows SharePoint Services 3.0
• Checklist 2: Business Portal 4.0 on Windows SharePoint Services 3.0 to Business Portal 

5.0 on Windows SharePoint Services 3.0
• Checklist 3: Business Portal 3.0 on Windows SharePoint Services 2.0 to Business Portal 

5.0 on Office SharePoint Server, Enterprise Edition
• Checklist 4: Business Portal 4.0 on Windows SharePoint Services 3.0 to Business Portal 

5.0 on Office SharePoint Server, Enterprise Edition
• Checklist 5: Business Portal 4.0 on Office SharePoint Server, Enterprise Edition to 

Business Portal 5.0 on Office SharePoint Server, Enterprise Edition
• Checklist 6: Business Portal 5.0 on Windows SharePoint Services 3.0 to Business Portal 

5.0 on Office SharePoint Server, Enterprise Edition
• System requirement changes
• Windows SharePoint Services vs. Office SharePoint Server
• Business Portal changes you should be aware of

Checklist Upgrade from Upgrade to

Checklist 1: Business Portal 3.0 on 
Windows SharePoint Services 2.0 to 
Business Portal 5.0 on Windows 
SharePoint Services 3.0

Business Portal 3.0 on Windows SharePoint 
Services 2.0

Business Portal 5.0 on Windows SharePoint 
Services 3.0

Business Portal 3.0 with Service Pack 1on 
Windows SharePoint Services 2.0

Checklist 2: Business Portal 4.0 on 
Windows SharePoint Services 3.0 to 
Business Portal 5.0 on Windows 
SharePoint Services 3.0

Business Portal 4.0 on Windows SharePoint 
Services 3.0

Business Portal 5.0 on Windows SharePoint 
Services 3.0

Business Portal 4.0 with Service Pack 2 on 
Windows SharePoint Services 3.0

Checklist 3: Business Portal 3.0 on 
Windows SharePoint Services 2.0 to 
Business Portal 5.0 on Office 
SharePoint Server, Enterprise Edition

Business Portal 3.0 on Windows SharePoint 
Services 2.0

Business Portal 5.0 on Microsoft Office 
SharePoint Server, Enterprise Edition

Business Portal 3.0 with Service Pack 1 on 
Windows SharePoint Services 2.0

Checklist 4: Business Portal 4.0 on 
Windows SharePoint Services 3.0 to 
Business Portal 5.0 on Office 
SharePoint Server, Enterprise Edition

Business Portal 4.0 on Windows SharePoint 
Services 3.0

Business Portal 5.0 on Microsoft Office 
SharePoint Server, Enterprise Edition

Business Portal 4.0 with Service Pack 2 on 
Windows SharePoint Services 3.0

Checklist 5: Business Portal 4.0 on 
Office SharePoint Server, Enterprise 
Edition to Business Portal 5.0 on Office 
SharePoint Server, Enterprise Edition

Business Portal 4.0 on Microsoft Office 
SharePoint Server, Enterprise Edition

Business Portal 5.0 on Microsoft Office 
SharePoint Server, Enterprise Edition

Business Portal 4.0 with Service Pack 2 on 
Microsoft Office SharePoint Server, Enterprise 
Edition

Checklist 6: Business Portal 5.0 on 
Windows SharePoint Services 3.0 to 
Business Portal 5.0 on Office 
SharePoint Server, Enterprise Edition

Business Portal 5.0 on Windows SharePoint 
Services 3.0

Business Portal 5.0 on Microsoft Office 
SharePoint Server, Enterprise Edition
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Upgrade process

Upgrading to Business Portal for Microsoft Dynamics GP 2010 is a complex process. 

From Business Portal 3.0
If you have customizations, you must first upgrade to Windows SharePoint Services 
3.0 or Office SharePoint Server 2007. If you do not have customizations, you can 
uninstall Windows SharePoint Services 2.0 and install a new version of SharePoint.

Because Business Portal has changed significantly with this release, not all 
customizations will be upgraded automatically. To retain customizations, you must 
run a migration utility to analyze the customizations you made to the previous 
release of Business Portal. Next, you must uninstall your current installation of 
Business Portal. Then, you can install Business Portal for Microsoft Dynamics GP 
2010. After you’ve installed the new release of Business Portal, you must run the 
utility again to move customizations to the new release.

To retain your data for use in Business Portal 5.0, uninstall Business Portal 3.0 so that only 
program files are removed. When you uninstall, in the Remove Options window, do not 
select the option to remove SQL objects and data. Your data will remain available for use in 
Business Portal 5.0.

Running the migration utility is an optional step in the upgrade process. You may 
choose to re-create your customizations manually in the new release of Business 
Portal. For more information about which customizations can be migrated, see How 
customizations are upgraded or migrated on page 23.

The following illustration shows the major steps in the upgrade process for 
upgrading from Business Portal 3.0 to Business Portal for Business Portal for 
Microsoft Dynamics GP 2010.

From Business Portal 4.0
If you are keeping your current SharePoint solution, you must uninstall your 
current installation of Business Portal. Then, you can install Business Portal for 
Microsoft Dynamics GP 2010. 

If you are going to upgrade to Office SharePoint Server 2007, you must uninstall 
your current installation of Business Portal. After you uninstall Business Portal, 
install Office SharePoint Server 2007 and run the SharePoint Products and 
Technologies Configuration Wizard. Then, you can install Business Portal for 
Microsoft Dynamics GP 2010. 
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Checklist 1: Business Portal 3.0 on Windows 
SharePoint Services 2.0 to Business Portal 5.0 on 
Windows SharePoint Services 3.0

Use this checklist as your guide to upgrading to a new release of Business Portal.

Upgrading from

Business Portal 3.0 on Windows SharePoint Services 2.0
Business Portal 3.0 with Service Pack 1on Windows SharePoint Services 2.0

Task For more information, see

1. Prepare for the upgrade. Check for new information relating to the 
upgrade since the release of this document.

Microsoft Dynamics GP documentation web site: 
http://go.microsoft.com/fwlink/?LinkId=163279

View the Readme file and make note of the 
items that pertain to your Business Portal 
system.

\\media\Documentation\Readme.rtf

Upgrade your hardware and software, if 
necessary.

System requirements on the Web:
http://go.microsoft.com/fwlink/?LinkID=161197

Identify the account used to access the 
shared reports folder.

Verify the account used to display reports in Reports 
Catalog on page 15.

Approve open workflow items. Approve all open workflow items on page 15.

Back up your Microsoft Dynamics GP 
databases and perform table maintenance.

Prepare Microsoft Dynamics GP databases for an 
upgrade on page 16.

2. Upgrade Windows 
SharePoint Services.
If you have no 
customizations, you can 
uninstall Windows 
SharePoint Services and 
install the newer version.

Choose a Windows SharePoint Services 
upgrade approach.

Determine the type of Windows SharePoint Services 
upgrade to perform on page 19.

Perform Windows SharePoint Services pre-
upgrade procedures.

Prepare to upgrade Windows SharePoint Services on 
page 20.

Run the Windows SharePoint Services 
upgrade script.

Run the Windows SharePoint Services upgrade script on 
page 20.

Upgrade Windows SharePoint Services. Upgrade to Windows SharePoint Services 3.0 on 
page 21.

3. Upgrade Microsoft 
Dynamics GP.

Upgrade to Microsoft Dynamics GP 2010. Microsoft Dynamics GP Upgrade Guide

5. Upgrade Business Portal 
and migrate customizations.

Install the Business Portal migration utility. Download and install the Business Portal migration 
utility on page 24.

Analyze customizations in the previous 
release of Business Portal.

Analyze customizations on page 25.

Uninstall the previous release of Business 
Portal.

Uninstall the previous release of Business Portal on 
page 26.

Create a web site for the new release of 
Business Portal.

Create a new web application and site collection on 
page 27.

Install Business Portal for Microsoft 
Dynamics GP 2010.

Install Business Portal for Microsoft Dynamics GP 2010 
on page 28.

Perform pre-migration steps. Prepare for the migration on page 29.

Migrate customizations. Migrate customizations on page 29.

6. Perform post-upgrade 
procedures, if necessary.

Learn about additional tasks you may have 
to perform after the upgrade.

Chapter 6, “After you upgrade.”

http://go.microsoft.com/fwlink/?LinkId=79222
http://go.microsoft.com/fwlink/?LinkID=161197
http://go.microsoft.com/fwlink/?LinkId=163279 
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Checklist 2: Business Portal 4.0 on Windows 
SharePoint Services 3.0 to Business Portal 5.0 on 
Windows SharePoint Services 3.0

Use this checklist as your guide to upgrading to a new release of Business Portal.

Upgrading from

Business Portal 4.0 on Windows SharePoint Services 3.0 
Business Portal 4.0 with Service Pack 1 on Windows SharePoint Services 3.0

Task For more information, see

1. Prepare for the upgrade. Check for new information relating to the 
upgrade since the release of this document.

Microsoft Dynamics GP documentation web site: 
http://go.microsoft.com/fwlink/?LinkId=163279

View the Readme file and make note of the 
items that pertain to your Business Portal 
system.

\\media\Documentation\Readme.rtf

Upgrade your hardware and software, if 
necessary.

System requirements on the Web:
http://go.microsoft.com/fwlink/?LinkID=161197

Identify the account used to access the 
shared reports folder.

Verify the account used to display reports in Reports 
Catalog on page 15.

Approve open workflow items. Approve all open workflow items on page 15.

Back up your Microsoft Dynamics GP 
databases and perform table maintenance.

Prepare Microsoft Dynamics GP databases for an 
upgrade on page 16.

2. Upgrade Microsoft 
Dynamics GP.

Upgrade to Microsoft Dynamics GP 2010. Microsoft Dynamics GP Upgrade Guide

4. Upgrade Business Portal. Uninstall the previous release of Business 
Portal.

Uninstall the previous release of Business Portal on 
page 26.

Install Business Portal for Microsoft 
Dynamics GP 2010.

Install Business Portal for Microsoft Dynamics GP 2010 
on page 28.

5. Perform post-upgrade 
procedures, if necessary.

Learn about additional tasks you may have 
to perform after the upgrade.

Chapter 6, “After you upgrade.”

http://go.microsoft.com/fwlink/?LinkId=163279 
http://go.microsoft.com/fwlink/?LinkID=161197
http://go.microsoft.com/fwlink/?LinkId=79222
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Checklist 3: Business Portal 3.0 on Windows 
SharePoint Services 2.0 to Business Portal 5.0 on 
Office SharePoint Server, Enterprise Edition

Use this checklist as your guide to upgrading to a new release of Business Portal.

Upgrading from

Business Portal 3.0 on Windows SharePoint Services 2.0
Business Portal 3.0 with Service Pack 1on Windows SharePoint Services 2.0

Task For more information, see

1. Prepare for the upgrade. Check for new information relating to the 
upgrade since the release of this document.

Microsoft Dynamics GP documentation web site: 
http://go.microsoft.com/fwlink/?LinkId=163279

View the Readme file and make note of the 
items that pertain to your Business Portal 
system.

\\media\Documentation\Readme.rtf

Upgrade your hardware and software, if 
necessary.

System requirements on the Web:
http://go.microsoft.com/fwlink/?LinkID=161197

Identify the account used to access the 
shared reports folder.

Verify the account used to display reports in Reports 
Catalog on page 15.

Approve open workflow items. Approve all open workflow items on page 15.

Back up your Microsoft Dynamics GP 
databases and perform table maintenance.

Prepare Microsoft Dynamics GP databases for an 
upgrade on page 16.

2. Upgrade Windows 
SharePoint Services.
If you have no 
customizations, you can 
uninstall Windows 
SharePoint Services and 
install the newer version.

Choose a Windows SharePoint Services 
upgrade approach.

Determine the type of Windows SharePoint Services 
upgrade to perform on page 19.

Perform Windows SharePoint Services pre-
upgrade procedures.

Prepare to upgrade Windows SharePoint Services on 
page 20.

Run the Windows SharePoint Services 
upgrade script.

Run the Windows SharePoint Services upgrade script on 
page 20.

Upgrade to Windows SharePoint Services 
3.0.

Upgrade to Windows SharePoint Services 3.0 on 
page 21.

Install Office SharePoint Server 2007. Migrate to Office SharePoint Server 2007 on page 21.

Run the SharePoint Products and 
Technologies Configuration Wizard.

Migrate to Office SharePoint Server 2007 on page 21.

Migrate to Office SharePoint Server 2007. Migrate to Office SharePoint Server 2007 on page 21.

3. Upgrade Microsoft 
Dynamics GP.

Upgrade to Microsoft Dynamics GP 2010. Microsoft Dynamics GP Upgrade Guide

4. Install or upgrade Web 
Services for Microsoft 
Dynamics GP, if necessary.

Upgrade to Web Services for Microsoft 
Dynamics GP 2010.

Web Services Installation and Administration Guide

5. Upgrade Business Portal 
and migrate customizations.

Install the Business Portal migration utility. Download and install the Business Portal migration 
utility on page 24.

Analyze customizations in the previous 
release of Business Portal.

Analyze customizations on page 25.

Uninstall the previous release of Business 
Portal.

Uninstall the previous release of Business Portal on 
page 26.

Create a web site for the new release of 
Business Portal.

Create a new web application and site collection on 
page 27.

Install Business Portal for Microsoft 
Dynamics GP 2010.

Install Business Portal for Microsoft Dynamics GP 2010 
on page 28.

Perform pre-migration steps. Prepare for the migration on page 29.

Migrate customizations. Migrate customizations on page 29.

6. Perform post-upgrade 
procedures, if necessary.

Learn about additional tasks you may have 
to perform after the upgrade.

Chapter 6, “After you upgrade.”

http://go.microsoft.com/fwlink/?LinkId=163279 
http://go.microsoft.com/fwlink/?LinkId=79222
http://go.microsoft.com/fwlink/?LinkID=161197
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Checklist 4: Business Portal 4.0 on Windows 
SharePoint Services 3.0 to Business Portal 5.0 on 
Office SharePoint Server, Enterprise Edition

Use this checklist as your guide to upgrading to a new release of Business Portal.

Upgrading from

Business Portal 4.0 on Windows SharePoint Services 3.0 
Business Portal 4.0 with Service Pack 1 on Windows SharePoint Services 3.0

Task For more information, see

1. Prepare for the upgrade. Check for new information relating to the 
upgrade since the release of this document.

Microsoft Dynamics GP documentation web site: 
http://go.microsoft.com/fwlink/?LinkId=163279

View the Readme file and make note of the 
items that pertain to your Business Portal 
system.

\\media\Documentation\Readme.rtf

Upgrade your hardware and software, if 
necessary.

System requirements on the Web:
http://go.microsoft.com/fwlink/?LinkID=161197

Identify the account used to access the 
shared reports folder.

Verify the account used to display reports in Reports 
Catalog on page 15.

Approve open workflow items. Approve all open workflow items on page 15.

Back up your Microsoft Dynamics GP 
databases and perform table maintenance.

Prepare Microsoft Dynamics GP databases for an 
upgrade on page 16.

2. Install Office SharePoint 
Server.
If you have no 
customizations, you can 
uninstall Windows 
SharePoint Services and 
install Office SharePoint 
Server.

Install Office SharePoint Server 2007. Migrate to Office SharePoint Server 2007 on page 21.

Run the SharePoint Products and 
Technologies Configuration Wizard.

Migrate to Office SharePoint Server 2007 on page 21.

Migrate to Office SharePoint Server 2007. Migrate to Office SharePoint Server 2007 on page 21.

3. Upgrade Microsoft 
Dynamics GP.

Upgrade to Microsoft Dynamics GP 2010. Microsoft Dynamics GP Upgrade Guide

4. Install or upgrade Web 
Services for Microsoft 
Dynamics GP, if necessary.

Upgrade to Web Services for Microsoft 
Dynamics GP 2010.

Web Services Installation and Administration Guide

5. Upgrade Business Portal. Uninstall the previous release of Business 
Portal.

Uninstall the previous release of Business Portal on 
page 26.

Install Business Portal for Microsoft 
Dynamics GP 2010.

Install Business Portal for Microsoft Dynamics GP 2010 
on page 28.

6. Perform post-upgrade 
procedures, if necessary.

Learn about additional tasks you may have 
to perform after the upgrade.

Chapter 6, “After you upgrade.”

http://go.microsoft.com/fwlink/?LinkId=163279 
http://go.microsoft.com/fwlink/?LinkID=161197
http://go.microsoft.com/fwlink/?LinkId=79222
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Checklist 5: Business Portal 4.0 on Office SharePoint 
Server, Enterprise Edition to Business Portal 5.0 on 
Office SharePoint Server, Enterprise Edition

Use this checklist as your guide to upgrading to a new release of Business Portal.

Checklist 6: Business Portal 5.0 on Windows 
SharePoint Services 3.0 to Business Portal 5.0 on 
Office SharePoint Server, Enterprise Edition

Use this checklist as your guide to upgrading to a new release of Business Portal.

Upgrading from

Business Portal 4.0 on Office SharePoint Server, Enterprise Edition
Business Portal 4.0 with Service Pack 1 on Office SharePoint Server, Enterprise Edition

Task For more information, see

1. Prepare for the upgrade. Check for new information relating to the 
upgrade since the release of this document.

Microsoft Dynamics GP documentation web site: 
http://go.microsoft.com/fwlink/?LinkId=163279

View the Readme file and make note of the 
items that pertain to your Business Portal 
system.

\\media\Documentation\Readme.rtf

Upgrade your hardware and software, if 
necessary.

System requirements on the Web:
http://go.microsoft.com/fwlink/?LinkID=161197

Identify the account used to access the 
shared reports folder.

Verify the account used to display reports in Reports 
Catalog on page 15.

Approve open workflow items. Approve all open workflow items on page 15.

Back up your Microsoft Dynamics GP 
databases and perform table maintenance.

Prepare Microsoft Dynamics GP databases for an 
upgrade on page 16.

2. Upgrade Microsoft 
Dynamics GP.

Upgrade to Microsoft Dynamics GP 2010. Microsoft Dynamics GP Upgrade Guide

3. Install or upgrade Web 
Services for Microsoft 
Dynamics GP, if necessary.

Upgrade to Web Services for Microsoft 
Dynamics GP 2010.

Web Services Installation and Administration Guide

4. Upgrade Business Portal. Uninstall the previous release of Business 
Portal.

Uninstall the previous release of Business Portal on 
page 26.

Install Business Portal for Microsoft 
Dynamics GP 2010.

Install Business Portal for Microsoft Dynamics GP 2010 
on page 28.

5. Perform post-upgrade 
procedures, if necessary.

Learn about additional tasks you may have 
to perform after the upgrade.

Chapter 6, “After you upgrade.”

Upgrade from

Business Portal 5.0 on Windows SharePoint Services 3.0

Task For more information, see

Upgrade Windows 
SharePoint Services.

Install Office SharePoint Server 2007. Migrate to Office SharePoint Server 2007 on page 21.

Run the SharePoint Products and 
Technologies Configuration Wizard.

Migrate to Office SharePoint Server 2007 on page 21.

Migrate to Office SharePoint Server 2007. Migrate to Office SharePoint Server 2007 on page 21.

http://go.microsoft.com/fwlink/?LinkId=163279 
http://go.microsoft.com/fwlink/?LinkID=161197
http://go.microsoft.com/fwlink/?LinkId=79222
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System requirement changes

The following system requirements have changed since the previous release of 
Business Portal.

• This release of Business Portal is compatible only with Microsoft Dynamics GP 
2010. You must upgrade to Microsoft Dynamics GP 2010 before you can 
upgrade Business Portal.

• You must install Business Portal for Microsoft Dynamics GP 2010 on Windows 
SharePoint Services 3.0 or on Office SharePoint Server 2007.

• Microsoft Windows 7 Professional Edition and Ultimate Edition are additional 
supported client operating systems.

• Internet Explorer® 8.0 is supported, but not required.

For complete system requirements, refer to http://go.microsoft.com/fwlink/
?LinkID=161197.

Windows SharePoint Services vs. Office SharePoint 
Server

You can install Business Portal for Microsoft Dynamics GP 2010 on either Windows 
SharePoint Services or Office SharePoint Server, Enterprise Edition.

Office SharePoint Server uses Windows SharePoint Services technology. Any 
features available in Windows SharePoint Services are also available in Office 
SharePoint Server. However, Office SharePoint Server offers additional features. For 
example, Office SharePoint Server uses the same search technology as Windows 
SharePoint Services, but includes the ability to search for data in business 
applications, such as Microsoft Dynamics GP.

If you install on Office SharePoint Server, Enterprise Edition, additional Business 
Portal and SharePoint features are available. The additional features include:

Search The Search feature integrates Web Services for Microsoft Dynamics GP 
with the Office SharePoint Server Business Data Catalog, which enables you to 
search for Microsoft Dynamics GP data, along with content from your SharePoint 
sites.

List pages List pages use the Business Data Catalog integration with the 
Microsoft Dynamics GP web service to display information from Microsoft 
Dynamics GP.

Report Center The Office SharePoint Server, Enterprise Edition, version of 
Business Portal uses the Report Center site for publishing Microsoft Dynamics GP 
reports. The Report Center site provides the flexibility to publish other types of 
reports, such as Management Reporter for Microsoft Dynamics ERP reports or 
reports from applications like Microsoft Excel®. Using SharePoint features, users 
can receive alerts when new reports are added to the Report Center, create 
document workspaces to collaborate on reports, set up workflows to review reports, 
and even access reports offline.

http://go.microsoft.com/fwlink/?LinkID=161197
http://go.microsoft.com/fwlink/?LinkID=161197
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Field Service Suite The Field Service Suite application is available only if 
you’re using Business Portal with Office SharePoint Server. Use this application to 
allow your customers to enter, view, and update service requests and return 
requests.

For more information about Search, list pages, and the Report Center, see the 
Business Portal Administrator’s Guide.

Business Portal changes you should be aware of

The following settings will be overwritten during the upgrade. We recommend that 
you write down any changes you made before upgrading so that you can re-create 
them after the upgrade.

Modifications to document workflow
If you’re using Human Resources Management (HRM) Self Service Suite, and you 
have made changes to a document’s workflow (on the Business Processes page), 
those changes will be overwritten during the upgrade. For more information, see 
the “Workflow Modifications” chapter in the HRM Self Service Suite 
Administrator’s Guide.

Modifications to cascading style sheets
If you have made changes to default Business Portal style sheets, your changes will 
be lost. During an upgrade, the style sheets will be returned to their original state; 
you will need to re-create your changes.

Modifications to navigation and security
Most changes to pages, web parts, lists, and libraries can be migrated after installing 
the new release of Business Portal. However, navigation modifications must be re-
created. In addition, some security settings will be upgraded, but others will not. 
For example, MBF role assignments and data permissions will be upgraded, but 
page permissions must be re-created. For more information, see How customizations 
are upgraded or migrated on page 23.

Modifications to the Executive Center
The Executive Center in Business Portal for Microsoft Dynamics GP 2010 displays 
new Key Performance Indicators (KPIs) and metrics created using Microsoft SQL 
Server Reporting Services 2008. If you have used KPIs in a previous release of 
Business Portal and upgrade to Business Portal for Microsoft Dynamics GP 2010, 
you can still access KPI web parts and your existing KPIs.

Modifications to document delivery
Electronic Document Delivery has been removed for Business Portal for Microsoft 
Dynamics GP 2010. You can use the e-mail functionality in Microsoft Dynamics GP 
to send documents in e-mail to your customers and vendors. 
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Chapter 2: Before you upgrade
This chapter provides information about tasks you must complete before you 
upgrade to Business Portal for Microsoft Dynamics GP 2010. This information is 
divided into the following sections:

• Verify the account used to display reports in Reports Catalog
• Approve all open workflow items
• Prepare Microsoft Dynamics GP databases for an upgrade
• Back up SharePoint databases

Verify the account used to display reports in Reports 
Catalog

Reports Catalog is 
available only if you’re 
using Business Portal 
with Windows 
SharePoint Services.

If you’re using Reports Catalog, use the following procedure to identify which 
account is used by the FileService application, which is used to display reports. 
During the upgrade, the account is reset to FileServiceUser. If the FileService 
application in your system is set up to use a different account, you must set it up 
again after the upgrade.

For more information about the user account for reports, refer to the Business Portal 
Installation Guide.

1. On the web server, open Component Services.
Start > Administrative Tools > Component Services

2. In the left pane, expand Component Services > Computers > My Computer > 
COM+ Applications.

3. Right-click Microsoft.BusinessPortal.Reports.FileService and select Properties 
to open the Microsoft.BusinessPortal.FileService Properties window.

4. Click the Identity tab. If FileServiceUser is listed in the User field, no further 
action is necessary.

If an account other than FileServiceUser is listed in the User field, note this 
information. You must enter this user account again after the upgrade.

5. Click OK to close the window.

Approve all open workflow items

If you are using the HRM Self Service Suite, you must approve all open workflow 
items—for example, timecards that have been submitted but not yet approved—
before you upgrade. To prevent documents from becoming corrupted, you must 
complete the following tasks:

• Ask your users to stop submitting new workflow items, such as timecards, 
vacation requests, and employee profile changes.
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• Use the Business Processes page (Site Settings > Application Settings > 
Workflow > Business Processes) to prevent users from submitting new 
documents for approval. For each document listed in the Business Process List 
web part, click the Options tab and select Suspend creation of new process 
instances.

• Use the Process Log page (Site Settings > Application Settings > Workflow > 
Process Log) to view the workflow items (documents) that are still in process. 
You can notify the users who still have open workflow items, or you can 
terminate the workflow item yourself. For more information about the Process 
Log page, see the HRM Self Service Suite Administrator’s Guide.

Prepare Microsoft Dynamics GP databases for an 
upgrade

Before you upgrade Business Portal, we recommend making a backup of your 
Microsoft SQL Server® databases and performing table maintenance procedures.

For more information about backing up databases in SQL Server, refer to SQL 
Server Books Online.

If you performed table maintenance procedures before you upgraded Microsoft 
Dynamics GP, you don’t need to do so again before upgrading Business Portal. 
However, we recommend that you make another backup of your Microsoft 
Dynamics GP databases before you upgrade Business Portal.

Back up Microsoft Dynamics GP data
You should make at least one complete backup of your Microsoft Dynamics GP 
databases before upgrading. It’s a good idea to make a backup before completing 
table maintenance procedures, in case you encounter any problems in that process.

Table maintenance
We recommend that you perform table maintenance procedures for all tables. For 
your SQL databases, you should perform the following procedures:

• Update statistics to reconfigure table keys.

• Recompile stored procedures to adapt stored procedures to tables with 
significant increases or decreases in data.

• Execute the following database maintenance routines against the databases in 
Query Analyzer. These database maintenance routines will ensure that your 
table structure is ready to be updated if there are no errors indicated.

DBCC CHECKDB

DBCC CHECKCATALOG

It’s a good idea to make a second backup after performing table maintenance, but 
before upgrading. Then, if you encounter unexpected problems while upgrading, 
you won’t have to repeat the table maintenance step.
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Back up SharePoint databases

Be sure to back up the the following SharePoint database before upgrading Business 
Portal:

• Content (WSS_Content) — the content database that stores the web application 
that Business Portal is installed to

• Configuration (SharePoint_Config)
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Chapter 3: Upgrade SharePoint
This chapter contains information about upgrading to Windows SharePoint 
Services 3.0 or Office SharePoint Server 2007.

If you are upgrading from Business Portal 3.0 and have customizations, you must 
upgrade to Windows SharePoint Services 3.0 before upgrading Business Portal to 
the current release. After you’ve upgraded to Windows SharePoint Services 3.0, you 
can migrate to Office SharePoint Server 2007, if necessary.

If you are upgrading from Business Portal 3.0 and do not have customizations, you 
can uninstall Windows SharePoint Services 2.0 and install Windows SharePoint 
Services 3.0 or Office SharePoint Server 2007 before upgrading Business Portal to 
the current release.

If you are upgrading from Business Portal 4.0 on Windows SharePoint Services 3.0, 
you can upgrade to Office SharePoint Server 2007 during the Business Portal 
upgrade to the current release. Or, you can migrate to Office SharePoint Server 2007 
after upgrading to the current Business Portal release.

This information is divided into the following sections:

• Determine the type of Windows SharePoint Services upgrade to perform
• Prepare to upgrade Windows SharePoint Services
• Run the Windows SharePoint Services upgrade script
• Upgrade to Windows SharePoint Services 3.0
• Migrate to Office SharePoint Server 2007

Determine the type of Windows SharePoint Services 
upgrade to perform

Before you start the upgrade process, you must choose the approach you will take 
to upgrading Windows SharePoint Services. 

Upgrade type Description Level of difficulty Best for

In-place upgrade Upgrades the content and 
configuration data in place, at one 
time. Updates existing databases 
and servers using existing 
hardware.

The easiest approach. Single server or small 
server farm.

Gradual upgrade Installs the new release side-by-
side with the previous release. The 
server administrator determines 
which site collections to upgrade 
and when to upgrade them. 
Enables a more granular 
approach; uses existing hardware.

A more complex and 
resource-intensive 
approach.

Medium or large server 
farms with many sites for 
which you must limit 
downtime.

Database 
migration 

Enables moving to a new farm or 
new hardware. Requires the server 
administrator to install the new 
release on a separate farm or 
separate hardware, and then 
manually migrate the databases 
into the new environment. 

A complex process that 
requires many manual 
steps and a higher risk 
of error.

Those who are moving to 
new hardware or a new 
architecture.
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Refer to the Windows SharePoint Services 3.0 Technical Library on Microsoft 
TechNet (technet.microsoft.com) for more information about Windows SharePoint 
Services upgrade approaches.

Prepare to upgrade Windows SharePoint Services

Before upgrading Windows SharePoint Services, you must perform the following 
pre-upgrade procedures.

• If you have not already applied Service Pack 2 to your Windows SharePoint 
Services 2.0 environment, you must do so before upgrading.

• Install prerequisites. The web server and application server computers must be 
running Microsoft Windows Server® 2003 with Service Pack 1, and must have 
Microsoft .NET Framework 3.0 and Microsoft ASP.NET 2.0.

• To ensure that you can recover your existing environment in case something 
goes wrong during the upgrade process, you must back up all of the databases 
that are used by Windows SharePoint Services before you run the upgrade 
process. 

• Use the pre-upgrade scan tool to scan your sites, and then fix any errors. If you 
have not successfully run this tool and you run the SharePoint Products and 
Technologies Configuration wizard, the wizard will exit and prompt you to run 
the tool. You can download the SharePoint Products and Technologies Utility: 
Upgrade Pre-scan Tool from the Microsoft Download Center 
(www.microsoft.com/downloads).

• If you are performing a gradual upgrade, you must have two separate domain 
names for your existing sites and your upgraded sites.

Refer to the Windows SharePoint Services 3.0 Technical Library on Microsoft 
TechNet (technet.microsoft.com) for more information about pre-upgrade 
procedures.

Run the Windows SharePoint Services upgrade script

Before you install or upgrade to Windows SharePoint Services 3.0, you must run an 
upgrade script.

Windows SharePoint Services 2.0 and Windows SharePoint Services 3.0 use 
different versions of ASP.NET. Running the upgrade script makes the previous 
version of Windows SharePoint Services compatible with the new version of 
ASP.NET. For more information about this problem and its resolution, see Microsoft 
Knowledge Base article 894903. (Go to support.microsoft.com and type 894903 in 
the Search box.)

Use the following procedure to run the upgrade script.

1. Open a Command Prompt window.

2. Change the working directory to \Program Files\Common Files\Microsoft 
Shared\Web Server Extensions\60\Bin.

http://technet.microsoft.com
http://technet.microsoft.com
http://support.microsoft.com
http://www.microsoft.com/downloads
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3. Type and run the following command:

stsadm -o upgrade -forceupgrade -url http://VirtualServerURL

For more information about using the stsadm.exe command-line tool, refer to the 
Windows SharePoint Services 2.0 Administrator’s Guide.

Upgrade to Windows SharePoint Services 3.0

You must upgrade to Windows SharePoint Services 3.0 before upgrading Business 
Portal. After you’ve upgraded to Windows SharePoint Services 3.0, you can migrate 
to Office SharePoint Server 2007, if necessary.

You can download Windows SharePoint Services 3.0 from the Microsoft Download 
Center (www.microsoft.com/downloads).

If you’re performing a gradual upgrade or a database migration of Windows 
SharePoint Services, be sure to upgrade the site collection where Business Portal or 
3.0 is installed before performing Business Portal upgrade procedures. For more 
information about upgrade types, see Determine the type of Windows SharePoint 
Services upgrade to perform on page 19.

For detailed information about upgrading Windows SharePoint Services, refer to 
the Windows SharePoint Services Technical Library on Microsoft TechNet 
(technet.microsoft.com).

Migrate to Office SharePoint Server 2007

If you want to use Office SharePoint Server in your configuration, you must 
purchase it separately.

Business Portal 3.0 If you have been using Microsoft Windows SharePoint 
Services 2.0 and have decided that you need the functionality of Office SharePoint 
Server, you must first upgrade to Windows SharePoint Services 3.0. Then you can 
install Office SharePoint Server over Windows SharePoint Services and perform the 
additional configuration needed for Office SharePoint Server. 

Refer to the Office SharePoint Server 2007 Technical Library on Microsoft TechNet 
(technet.microsoft.com) for information about migrating. Refer to the Business 
Portal Installation Guide for information about configuring Office SharePoint 
Server for Business Portal.

Business Portal 4.0 You can install Office SharePoint Server over Windows 
SharePoint Services and perform the additional configuration needed for Office 
SharePoint Server. 

Refer to the Office SharePoint Server 2007 Technical Library on Microsoft TechNet 
(technet.microsoft.com) for information about migrating. Refer to the Business 
Portal Installation Guide for information about configuring Office SharePoint 
Server for Business Portal.

Business Portal 5.0 If you migrate to Office SharePoint Server after installing 
Business Portal 5.0, additional setup is required. For more information, see the 
Business Portal Implementation Guide (http://go.microsoft.com/fwlink/
?LinkID=190897). 

http://www.microsoft.com/downloads
http://technet.microsoft.com
http://technet.microsoft.com
http://technet.microsoft.com
http://go.microsoft.com/fwlink/?LinkID=190897
http://go.microsoft.com/fwlink/?LinkID=190897
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Chapter 4: Upgrading from Business Portal 3.0
This chapter contains the procedures to upgrade to Business Portal for Microsoft 
Dynamics GP 2010, in the order they must be performed if you are upgrading from 
Business Portal 3.0. Before you upgrade Business Portal, be sure to perform the 
procedures and review the information in Chapter 2, “Before you upgrade,” and 
Chapter 3, “Upgrade SharePoint.”

This information is divided into the following sections:

• How customizations are upgraded or migrated
• Download and install the Business Portal migration utility
• Analyze customizations
• Uninstall the previous release of Business Portal
• Create a new web application and site collection
• Install Business Portal for Microsoft Dynamics GP 2010
• Prepare for the migration
• Migrate customizations

How customizations are upgraded or migrated

After you’ve upgraded to Windows SharePoint Services 3.0, you can run the 
Business Portal Migration Utility to analyze which of your Windows SharePoint 
Services customizations can be migrated. After you have run the analysis, you can 
upgrade Business Portal and then run the migration utility to move your 
customizations to the new release. 

Running the migration utility is optional. If you choose not to run the utility, 
upgrading Business Portal will upgrade some of your data, but none of your 
SharePoint changes will be migrated.

Items that will be upgraded
You don’t need to use the migration utility for changes to Microsoft Business 
Framework (MBF) data. The following MBF items will be upgraded automatically 
when you install Business Portal for Microsoft Dynamics GP 2010.

• Roles and role assignments
• Users
• Data permissions and data permission assignments
• Queries

For more information about MBF, refer to the Business Portal Administrator’s 
Guide. 
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Items that can be migrated
You can use the migration utility to migrate the following items.

• New web parts
• Modifications to default web parts, including titles, query associations, number 

of rows returned, and publish/subscribe settings
• New pages
• SharePoint lists and libraries that don’t contain folders

Only items from the Business Portal site collection (<ServerName:Port>/sites/
businessportal) will be migrated. If you have created additional subsites in the 
Business Portal site collection, the pages and lists from those sites can’t be migrated.

If you’ve modified a default Business Portal page, that modification will be 
migrated to the corresponding page in the new release of Business Portal. If you’ve 
created new pages, lists, and libraries, you can select the sites to move them to. To 
migrate new pages and lists to a new Business Portal subsite, you must create that 
new subsite before performing the migration.

Items that won’t be upgraded or migrated
The following items can’t be moved to the new release of Business Portal, either 
through the upgrade or through the migration utility.

• Pages that were not created through Business Portal
• Modifications to default web part sizes and positions
• SharePoint lists and libraries that contain folders
• SharePoint surveys
• SharePoint discussion boards
• SharePoint galleries
• Navigation changes
• Page security
• Evidence items from the Microsoft Office Solution Accelerator for Sarbanes-

Oxley

Download and install the Business Portal migration 
utility

Before you can run the migration utility, you must download it and install it on the 
computer where you are performing the Business Portal upgrade.

If you don’t want to migrate changes to Windows SharePoint Services items such as pages, 
web parts, lists, and libraries, you don’t need to use the migration utility. For more 
information, see How customizations are upgraded or migrated on page 23.

1. Download the migration utility from CustomerSource. 

2. Double-click the Microsoft_DynamicsGP11_BPMigrationUtility_x86_en-us.msi 
file.

3. The End-User License Agreement window appears. Read and accept the terms 
and conditions, then select I accept the terms in the License Agreement, and 
click Next.
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4. The Ready to Install window appears. Click Install.

5. The Finish window appears. Click Finish.

Analyze customizations

Use the migration utility to view customizations to your previous Business Portal 
installation. You can also use the utility to select which customizations to move to 
the new release of Business Portal. 

If you don’t want to migrate changes to Windows SharePoint Services items such as pages, 
web parts, lists, and libraries, you don’t need to use the migration utility. For more 
information, see How customizations are upgraded or migrated on page 23.

The user running the migration utility must have the following permissions:

• Business Portal administrator
• Administrator of the site collection where Business Portal is installed
• Administrator of the web server computer

The user running the migration utility must be the same user who ran the 
SharePoint Products and Technologies Configuration wizard during the Windows 
SharePoint Services upgrade.

Analyzing customizations
1. Start the migration utility.

Start > Programs > Business Portal Migration Utility > Business Portal 
Migration Utility

2. The Welcome window appears. Select Analyze, then click Next. When the 
analysis is complete, you can close the command prompt window.

3. The View window appears, where you can view the results of the analysis.

The results are saved to the Analysis.xml file, located in the Migration\Data 
folder in the Business Portal bin folder. (The bin folder is located in the directory 
specified by the IIS virtual server set up for the Business Portal. If Business 
Portal was installed on the Default Web Site, the bin folder is located in 
C:\Inetpub\wwwroot.)

Excluding items from analysis
In certain situations, the analysis may encounter an unexpected error and stop 
processing. You must exclude the item causing the error so the analysis can 
continue.

1. Determine which item is causing the error. You can view error information in 
the analysis command window or in the AnalysisLog-<date>_<time> file, 
located in the Migration\Data folder in the Business Portal bin folder.

The bin folder is located in the directory specified by the IIS virtual server set up 
for the Business Portal. (If Business Portal was installed on the Default Web Site, 
the bin folder is located in C:\Inetpub\wwwroot.)

2. Create a backup copy of the Microsoft.BusinessPortal.Migration.
Analyze.exe.config file located in the bin folder.
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3. Open the configuration file using a text editor, such as Notepad.

4. Add pages to the <CustomExcludedPages> section in the following format:

<add key="CustomExcludedPages" value="PageName1.aspx,PageName2.aspx"/>

Add lists to the <CustomExcludedLists> section in the following format:

<add key="CustomExcludedLists" value="ListName1,ListName2"/>

5. Save and close the configuration file. 

6. Run the analysis again.

Uninstall the previous release of Business Portal

Use the installation wizard to remove Release 3.0 of Business Portal or Business 
Portal 3.0 with Service Pack 1 from your computer.

If there are applications, such as Requisition Management, that you no longer want 
to use, you must uninstall them before removing Business Portal. 

Uninstallation known issue
You may encounter errors from the following programs when uninstalling Business 
Portal:

• Microsoft.BusinessPortal.Install.DocumentLibraryCreator.exe
• Microsoft.BusinessPortal.Install.BPPageLibraryPageManager.exe

You can disregard these errors.

Uninstalling Business Portal
1. Open the Add or Remove Programs control panel, and select Microsoft 

Dynamics GP Business Portal. Click Change to open the Modify Business Portal 
Installation window.

2. Click Remove.

3. The Remove Options window appears. Do not select the option to remove SQL 
objects and data.

If you remove SQL objects and data, your MBF data, such as roles, users, and data 
permissions, will be lost. In addition, you will not be able to migrate your SharePoint 
customizations to the new release of Business Portal.

Click Next.

4. The Verify Microsoft Dynamics GP Business Portal Removal window appears.

Click Back to review or change your options for removing Business Portal.

Click Remove to remove Business Portal from your computer.

5. After processing is finished, the final window appears. Click Finish to close the 
wizard.
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Create a new web application and site collection

If you are upgrading from Business Portal 3.0, Business Portal for Microsoft 
Dynamics GP 2010 must be installed to a new web application and site collection. 
You can’t install it on the site where the previous release of Business Portal was 
installed.

If the previous release of Business Portal was installed on the Default Web Site and 
you want to install the new release on port 80, you must delete the Default Web Site 
through SharePoint Central Administration. Then you can create a new SharePoint 
web application that uses port 80.

For more information about web applications and site collections, refer to the 
Windows SharePoint Services 3.0 Technical Library on Microsoft TechNet 
(technet.microsoft.com).

If you are upgrading from Business Portal 4.0, you don’t need to complete this procedure. 
You should use the same site collection that you used for the previous release.

Creating a web application
1. Open SharePoint Central Administration. 

Start > Administrative Tools > SharePoint Central Administration

2. Click Application Management.

3. Under the SharePoint Web Application Management heading, click Create or 
extend Web application.

4. Click Create a new Web application. 

5. Select an IIS web site and security configuration.

6. In the Application Pool section, click Create a new application pool and enter 
a name (we recommend calling the new application pool BusinessPortal).

When a web application fails, it usually causes the application pool to fail, as well. If you 
are going to install other web applications on this server, we recommend that you assign 
them to separate application pools. That way, one failed application can’t cause the other 
applications to fail.

7. Click Configurable and enter a domain account. Be sure to enter the account in 
domain\username format.

8. Verify that the database name and other information on the page is correct and 
click OK. When the process is complete, the Application Created page is 
displayed. 

9. On the Application Created page, click Create Site Collection. 

Creating a site collection
1. If you’re not already on the Create Site Collection page, go to SharePoint 

Central Administration and click Application Management. Under the 
SharePoint Site Management heading, click Create site collection.

2. Select the web application you just created.

http://technet.microsoft.com
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3. Enter a title and description for the site collection.

4. Specify the URL for the site collection, if necessary.

Be sure that the URL does not contain spaces.

5. Select a site template. If you’re using Windows SharePoint Services, select the 
Team Site site template. If you’re using Office SharePoint Server, select the 
Collaboration Portal site template.

6. Specify a site collection administrator.

7. Click OK.

Install Business Portal for Microsoft Dynamics GP 
2010

You must upgrade Microsoft Dynamics GP to Release 2010 before installing 
Business Portal.

If an application, such as Requisition Management, was installed with the previous 
release of Business Portal, be sure that the application is selected as a feature to 
install when you upgrade. If there are applications you no longer want to use, you 
must uninstall them before upgrading. 

You can install new applications, if you register them in Microsoft Dynamics GP 
before you upgrade. Some applications also require features to be installed in 
Microsoft Dynamics GP. For more information about entering registration keys, 
refer to your Microsoft Dynamics GP documentation. For the installation 
requirements of specific Business Portal applications, see the documentation for the 
applications that you want to install.

The person installing Business Portal must be logged on to the web server computer 
as a user with the following access rights:

• A member of the Administrators group on the web server where Business 
Portal is being uninstalled and reinstalled.

• The administrator of the site collection where Business Portal is being installed.

• Administrator rights to the SQL server where Microsoft Dynamics GP 
information is stored, if you’re using Windows Trusted Authentication for the 
Business Portal installation.

• Access to the Microsoft Dynamics GP web service, if you’re installing Business 
Portal on Office SharePoint Server. If you’re not already in a web service role, 
we recommend using the BDC Administrator role.

For detailed information about installing Business Portal, see the Business Portal 
Installation Guide.
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Prepare for the migration

The migration utility was installed in the Business Portal bin folder. Whether you 
created a new site or installed Business Portal on a new IIS server, the bin folder 
location for the Business Portal web site has changed from previous releases. You 
must complete the following steps before performing the migration.

If you don’t want to migrate changes to items, such as pages, web parts, lists, and libraries, 
in Windows SharePoint Services, you don’t need to use the migration utility. For more 
information, see How customizations are upgraded or migrated on page 23.

1. Use Add or Remove Programs in the Windows Control Panel to uninstall the 
migration utility from the server where you performed the analysis.

2. Install the migration utility on the server where the new Business Portal web 
site resides. (This may be the same server as in the previous step.)

For information about installing the utility, see Download and install the Business 
Portal migration utility on page 24.

3. Copy the contents of the Migration folder from the old bin folder to the new bin 
folder. 

In the previous release of Business Portal, the bin folder was located in the 
directory specified by the IIS virtual server set up for the Business Portal. (If 
Business Portal was installed on the Default Web Site, the bin folder is located at 
C:\Inetpub\wwwroot.)

In the new release of Business Portal, the bin folder is located at C:\inetpub
\wwwroot\wss\VirtualDirectories\<port number>, where <port number> is the 
port number of the IIS web site where Business Portal is installed.

Migrate customizations

After you’ve upgraded Windows SharePoint Services and installed Business Portal 
for Microsoft Dynamics GP 2010, you can use the migration utility to migrate your 
customizations. 

If you don’t want to migrate changes to items, such as pages, web parts, lists, and libraries, 
in Windows SharePoint Services, you don’t need to use the migration utility. For more 
information, see How customizations are upgraded or migrated on page 23.

Migration known issues
• When a list is being migrated, a temporary list is created on the top-level site in 

the Business Portal site collection. If a list or library that you created has the 
same name as a list that already exists on the top-level site, your version of the 
list or library will not be migrated. To migrate your lists and libraries, you must 
first delete the list with the same name from the top-level site collection.
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• Result viewer web parts that use the standard method of publishing and 
subscribing (rather than an alternative method) will be disconnected from one 
another after migration. You must manually set up the connection between 
these web parts.

• If a KPI web part fails to migrate, we recommend running the migration again 
with only that web part selected. The KPI web part should then migrate 
successfully.

Migrating customizations
To migrate customizations, Business Portal for Microsoft Dynamics GP 2010 must 
be installed. The user running the migration utility must be the administrator of the 
site collection where Business Portal is installed and the administrator of the web 
server computer.

The user running the migration utility must be the same user who ran the 
SharePoint Products and Technologies Configuration wizard during the Windows 
SharePoint Services upgrade.

1. Start the migration utility.
Start > Programs > Microsoft Dynamics > Business Portal Migration Utility

2. The Welcome window appears. Select Migrate, then click Next.

3. The View Migration Results window appears.

4. For new pages, SharePoint lists, or SharePoint libraries, use the Site field to 
select the Business Portal site to move the page, list, or library to.

By default, permissions for lists and libraries are inherited from the parent site. 
To make security administration easier, be sure to select a site that has the 
appropriate permissions for the list or library.

5. For new pages, use the Library field to select a library within the site where the 
page will be stored.

By default, permissions for pages are inherited from the parent list or library. To 
make security administration easier, be sure to select a library that has the 
appropriate permissions for the page.

6. Select the Migrate check box for each customized element to migrate to the new 
release of Business Portal.

7. To save your changes and migrate at a later time, click Save. To begin migrating 
your changes, click Migrate. 

8. When the migration is complete, you can close the command prompt window. 
The View Migration Results window appears.
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The Status column shows the migration status of each item. If there is no 
information in the status column, the migration has not been run, and there are 
no issues that could interfere with migration. Status icons are shown in the 
following table:

Migration results are saved to the Analysis.xml file, located in the 
Migration\Data folder in the Business Portal bin folder. (The bin folder is 
located in the directory specified by the IIS virtual server set up for the Business 
Portal. If Business Portal was installed on the Default Web Site, the bin folder is 
located at C:\Inetpub\wwwroot.)

In certain situations, the migration may encounter an unexpected error and stop 
processing. You can view error information in the MigrateLog-<date>_<time> file, 
located in the Migration\Data folder in the Business Portal bin folder. If you are unable 
to fix the problem, you must clear the check box for the item causing the error and 
restart the migration. 

Icon Result

Failed. The migration was attempted, but failed for this component.

Warning. The migration has not been attempted, but there is an issue 
that could prevent migration.

Success. The migration was successful.
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Chapter 5: Upgrading from Business Portal 4.0
This chapter contains the procedures to upgrade to Business Portal for Microsoft 
Dynamics GP 2010 from Business Portal 4.0. Before you upgrade Business Portal, be 
sure to perform the procedures and review the information in Chapter 2, “Before 
you upgrade,” and Chapter 3, “Upgrade SharePoint.”

This information is divided into the following sections:

• Uninstall the previous release of Business Portal
• Install Business Portal for Microsoft Dynamics GP 2010

Uninstall the previous release of Business Portal

Use the installation wizard to remove Release 4.0 of Business Portal or Business 
Portal 4.0 with Service Pack 2 from your computer.

If there are applications, such as Requisition Management, that you no longer want 
to use, you must uninstall them before removing Business Portal. 

Uninstallation known issue
You may encounter errors from the following programs when uninstalling Business 
Portal:

• Microsoft.BusinessPortal.Install.DocumentLibraryCreator.exe
• Microsoft.BusinessPortal.Install.BPPageLibraryPageManager.exe

You can disregard these errors.

Uninstalling Business Portal
1. Open the Add or Remove Programs control panel, and select Microsoft 

Dynamics GP Business Portal. Click Change to open the Modify Business Portal 
Installation window.

2. Click Remove.

3. The Remove Options window appears. Do not select the option to remove SQL 
objects and data.

If you remove SQL objects and data, your MBF data, such as roles, users, and data 
permissions, will be lost. In addition, you will not be able to migrate your SharePoint 
customizations to the new release of Business Portal.

Click Next.

4. The Verify Microsoft Dynamics GP Business Portal Removal window appears.

Click Back to review or change your options for removing Business Portal.

Click Remove to remove Business Portal from your computer.

5. After processing is finished, the final window appears. Click Finish to close the 
wizard.
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Install Business Portal for Microsoft Dynamics GP 
2010

You must upgrade Microsoft Dynamics GP to Release 2010 before installing 
Business Portal.

If an application, such as Requisition Management, was installed with the previous 
release of Business Portal, be sure that the application is selected as a feature to 
install when you upgrade. If there are applications you no longer want to use, you 
must uninstall them before upgrading. 

You can install new applications, if you register them in Microsoft Dynamics GP 
before you upgrade. Some applications also require features to be installed in 
Microsoft Dynamics GP. For more information about entering registration keys, 
refer to your Microsoft Dynamics GP documentation. For the installation 
requirements of specific Business Portal applications, see the documentation for the 
applications that you want to install.

The person installing Business Portal must be logged on to the web server computer 
as a user with the following access rights:

• A member of the Administrators group on the web server where Business 
Portal is being uninstalled and reinstalled.

• The administrator of the site collection where Business Portal is being installed.

• Administrator rights to the SQL server where Microsoft Dynamics GP 
information is stored, if you’re using Windows Trusted Authentication for the 
Business Portal installation.

• Access to the Microsoft Dynamics GP web service, if you’re installing Business 
Portal on Office SharePoint Server. If you’re not already in a web service role, 
we recommend using the BDC Administrator role.

For detailed information about installing Business Portal, see the Business Portal 
Installation Guide.
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Chapter 6: After you upgrade
This chapter provides information about tasks you may need to complete after you 
upgrade to Business Portal for Microsoft Dynamics GP 2010.

This information is divided into the following sections:

• Re-create security settings
• Re-create list web parts
• Upgrading Search for Business Portal 5.0
• Use the Report Center site in place of Reports Catalog
• Change the account used to display reports in Reports Catalog
• Set up and assign pay schedules
• Salesperson data access
• Delete temporary Internet files on client computers

Re-create security settings

There are two types of information to secure in Business Portal: back office data and 
SharePoint content. 

Security for data is set up using the Microsoft Business Framework (MBF) and Web 
Services for Microsoft Dynamics GP. Security for Business Portal sites and pages, 
along with SharePoint content, such as document libraries and announcements, is 
set up using Windows SharePoint Services. (In previous releases of Business Portal, 
page security was handled using MBF.) 

In Business Portal for Microsoft Dynamics GP 2010, MBF roles, web service roles, 
and SharePoint groups are not synchronized automatically. You must set up page 
security and data security separately.

For more information about security in Business Portal for Microsoft Dynamics GP 2010, 
see the Business Portal Administrator’s Guide.

Adding users to security groups
Your existing MBF roles, users, data permissions, role assignments, and data 
permission assignments were upgraded automatically when you installed Business 
Portal for Microsoft Dynamics GP 2010. However, if you’re using Business Portal 
with Office SharePoint Server, you must add users to web service roles. 

Many SharePoint groups were created by default when you installed the new 
release of Business Portal. To give users access to pages, you must add your users to 
these SharePoint groups. 

The Microsoft Dynamics Security Synchronization Utility, a Microsoft Management 
Console snap-in, enables you to synchronize role membership between 
applications. Because MBF security was preserved during the Business Portal 
upgrade, you can begin setting up security by synchronizing MBF role membership 
with default Business Portal SharePoint groups.



C H A P T E R  6    A F T E R  Y O U  U P G R A D E

36 U P G R A D E G U I D E

If you have created custom MBF roles, you may need to create custom SharePoint 
groups that correspond to those roles for page security. If you create the custom 
groups before you synchronize, you can synchronize them along with the default 
roles and groups.

The Security Synchronization Utility is available as a download on CustomerSource (https:/
/mbs.microsoft.com/customersource). For more information, refer to the documentation 
provided with the utility.

Re-creating page permissions
Page security changed significantly in Business Portal 4.0. If you are upgrading 
from Business Portal 3.0, you must re-create the page permissions that you made in 
Business Portal 3.0. You shouldn’t have to re-create page permissions if you are 
upgrading from Business Portal 4.0.

To help you re-create page security settings, you can download the Business Portal 
Permissions Report from CustomerSource. This report lists MBF roles and page 
permissions from the previous release of Business Portal. Because MBF security 
tables were preserved during the upgrade, you can run the report either before or 
after installing the new release of Business Portal. 

In addition, you can download a spreadsheet that lists the default permissions for 
every page in the new version of Business Portal. 

Use these two tools, along with the Security Synchronization Utility, to re-create 
your page permissions in the new release of Business Portal.

Verifying security on migrated libraries and pages
If you created new pages and document libraries and moved them using the 
migration utility, you should make sure that security is set appropriately in the new 
installation of Business Portal. By default, permissions for pages are inherited from 
the parent library and permissions for libraries are inherited from the parent site. 

• To verify security on a document library, go to the site for the library and click 
View All Site Content in the Quick Launch. Click the name of the document 
library that you want to verify security for. Click Settings > Document Library 
Settings. Under Permissions and Management, click Permissions for this 
document library. The users and SharePoint groups with access to the library 
are listed.

• To verify security on a specific page, go to the site for the page and click View 
All Site Content in the Quick Launch. Click the name of the document library 
that the page is stored in. Click the drop-down arrow for the page, and click 
Manage Permissions. The users and SharePoint groups with access to the page 
are listed.

https://mbs.microsoft.com/customersource
https://mbs.microsoft.com/customersource
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Re-create list web parts

If you used the migration utility, placeholder web parts will appear in place of list 
web parts on migrated pages. List web parts must be re-created.

1. On a page with a placeholder web part, click Site Actions > Edit Page. The page 
will switch to edit mode.

2. In the web part zone where you want to add the web part, click Add a Web 
Part.

3. In the Lists and Libraries section of the Add Web Parts dialog box, select the list 
that you are creating a web part for. 

For modified lists, the phrase “from migration” was appended to the list name during 
migration. For lists that you created, the names didn’t change.

4. Click Add to add the web part to the page.

5. To delete the placeholder web part, click Edit > Delete in its web part menu.

6. Exit edit mode.

Upgrading Search for Business Portal 5.0

Search functionality is 
available only if you’re 
using Business Portal 
with Office SharePoint 
Server, Enterprise 
Edition. 

The Search feature uses the Business Data Catalog, SharePoint Search Engine, and 
the Microsoft Dynamics GP web service to allow users to locate Microsoft Dynamics 
GP data, in addition to content stored on SharePoint sites. After you upgrade to 
Business Portal 5.0, you must complete the following tasks to upgrade Search.

Export resources
If you have customized permission, properties, or localized names, you must export 
the resource information. You must do this for each company that you are using 
Search for.

1. On the Business Portal web server, open SharePoint Central Administration by 
choosing Start > Administrative Tools > SharePoint 3.0 Central 
Administration.

2. In the Quick Launch, click the name of the Shared Service Provider used for 
Business Portal.

3. On the Shared Services Administration site home page, in the Business Data 
Catalog section, click View applications.

4. On the Business Data Catalog Applications page, in the Applications list, click 
the name of the application.

5. On the View Application: Application page, in the Application Information 
section, click Export Application Definition. 

6. In the File Type section, select the type of application definition to export. 

7. In the Resources to export section, select the resources to export. 
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8. Click Export.

9. In the File Download dialog, click Save and select a location to save the 
application definition.

10. Click Save.

Use the Microsoft Dynamics GP Search Setup wizard
You’ll use the Microsoft Dynamics GP Search Setup wizard to inactivate companies 
to remove all previous search data. Then, you’ll activate companies for Search. 

1. Start the Microsoft Dynamics GP Search Setup wizard. (On a Business Portal 
web server, go to Start > Administrative Tools > Microsoft Dynamics GP 
Search Setup.)

2. Click Inactivate All to inactive search for all companies.

3. Click Activate to set up search for the companies. You can use the wizard to 
specify which companies to activate Search for and select which entities and 
fields to include in searches. You’ll also select a default crawl schedule. For 
more information, refer to the Business Portal Administrator’s Guide.

4. Close the Microsoft Dynamics GP Search Setup wizard and return to SharePoint 
Central Administration.

Import resources
After the companies are activated to use Search, you’ll import resource information 
for those companies.

1. Return to SharePoint Central Administration.

2. In the Quick Launch, click the name of the Shared Service Provider used for 
Business Portal.

3. On the Shared Services Administration site home page, in the Business Data 
Catalog section, click Import application definition.

4. On the Import Application Definition page, in the Application Definition 
section, enter the location of the application definition.

5. In the File Type section, select the type of application definition to import. 

6. In the Resources to import section, select the resources to import.

7. Click Import.
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Use the Report Center site in place of Reports Catalog

The Report Center site 
is available only if 
you’re using Business 
Portal with Office 
SharePoint Server, 
Enterprise Edition. 

Reports Catalog is not available if you’re using Business Portal with Office 
SharePoint Server. If you previously used Reports Catalog to publish your 
Microsoft Dynamics GP reports in Business Portal, we recommend publishing your 
reports to the Report Center site instead.

The Report Center is a site in Office SharePoint Server, Enterprise Edition, that 
serves as a central location to manage business-critical information sources, such as 
reports, spreadsheets, and SQL Reporting Services data connections. When you 
install Business Portal, additional report libraries are created on this Report Center 
site for Microsoft Dynamics GP reports. 

For more information about using the Report Center site with Business Portal, see 
the Business Portal Administrator’s Guide.

Move existing report files
You can upload existing report files from your shared reports folder to the Report 
Center site using standard SharePoint functionality.

Uploading files to report libraries works just like uploading files to any other 
SharePoint document library. You can also use document library features to control 
how documents are viewed, tracked, managed, and created. You can track versions, 
including how many and which type of versions, and you can limit who can see 
documents before they are approved.

For more information about uploading and managing files, see the SharePoint 
documentation.

Manually uploading a report to the Report Center site does not change how it is 
automatically published. To change the location that reports are published to, use the Report 
Scheduler.

Publish new reports to the Report Center site
Just like Reports Catalog, reports can be published automatically to the Report 
Center site using the Microsoft Dynamics GP Report Scheduler.

Users who have a Microsoft Dynamics GP user ID can create, schedule, and publish 
new reports and assign those reports to Report Center site libraries using Report 
Scheduler. You can access Report Scheduler by choosing Microsoft Dynamics GP > 
Tools > Routines > Company > Report Schedule in Microsoft Dynamics GP. 

For more information about using Report Scheduler with Office SharePoint Server, 
refer to the Report Scheduler documentation.

Change the account used to display reports in Reports 
Catalog

Reports Catalog is 
available only if you’re 
using Business Portal 
with Windows 
SharePoint Services.

If you’re using Reports Catalog, the account used to display reports is reset to 
FileServiceUser during the upgrade. If the FileService application in your system is 
set up to use a different account, you must set it up again after the upgrade using 
this procedure.

For more information about sharing a reports folder, refer to the Business Portal 
Installation Guide.
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1. On the web server, open Component Services.
Start > Administrative Tools > Component Services

2. In the left pane, expand Component Services > Computers > My Computer > 
COM+ Applications.

3. Right-click on Microsoft.BusinessPortal.Reports.FileService and select 
Properties to open the Microsoft.BusinessPortal.FileService Properties window.

4. Click the Identity tab.

5. In the User field, enter the account that you want the COM+ application to use 
to access the shared reports folder.

6. Enter and confirm the password for the account.

7. Click OK to close the window.

Set up and assign pay schedules

In previous releases of Business Portal, the pay schedules that were defined in 
Human Resources automatically appeared in Business Portal when both Human 
Resources and Payroll were marked in the Back Office Settings web part. This web 
part has been removed, and back office registration now determines whether pay 
schedules from Human Resources are used.

If you’re using Human Resources Management Self Service Suite, and both the 
Human Resources and Payroll back office modules are registered—and both were 
marked in the Back Office Settings web part—you must set up and assign new pay 
schedules in Business Portal.

For more information, see the “Pay Schedules” chapter in the Human Resources 
Management Self Service Suite Administrator’s Guide.

Salesperson data access

Some data permissions have been removed from the Salesperson MBF role in order 
to improve security. To make the information available again, you must use new 
row-level restrictions we’ve provided.

Default data permission changes
The following default data permissions have been removed from the Salesperson 
MBF role:

• Salesperson Summary – All
• Salesperson Period Summary – All
• Receivables Commission – All
• Receivables Commission History - All
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Default query changes
Because data permissions were removed, information from the following default 
queries is no longer available to users in the Salesperson MBF role.

• My Sales
• Salesperson Commissions 
• Salesperson Summary
• Top Salespeople YTD
• Total Commissions by Salesperson YTD
• Salesperson Period Summary
• Salesperson Commission Detail
• Top Salesperson Current Period

In addition, salesperson fields are no longer available in queries that use the 
Receivables Commission History entity.

New row-level restrictions
To make information from the Salesperson Summary, Salesperson Period Summary, 
Receivables Commission, and Receivables Commission History entities available, 
we recommend creating new data permissions for these entities using the 
corresponding row-level restriction policies.

When a row-level restriction is used with a data permission, the Salesperson ID 
associated with a user determines which data is displayed. Row-level restriction 
policies for these entities are provided by default.

After you’ve created new data permissions, you must create new queries to display 
this information. 

For more information about row-level restrictions, data permissions, and queries, 
see the Business Portal Administrator’s Guide.

Delete temporary Internet files on client computers

Some Business Portal pages are cached by Internet Explorer for 30 days. After an 
upgrade, these temporary files need to be deleted so that new versions will be 
displayed, instead. If the temporary files are not deleted, errors may occur when 
users attempt to access certain cached pages.

Temporary Internet Explorer files are saved for each user on a single computer. If 
multiple users share a single client workstation, temporary files will need to be 
deleted with each of the users logged on to the workstation.

To delete temporary Internet files in Internet Explorer 7.0 
or Internet Explorer 8.0:
1. Start Internet Explorer and open the Internet Options window.

Tools > Internet Options

2. Click the General tab. Under Browsing history, click Delete.
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3. The Delete Browsing History window is displayed. Under Temporary Internet 
Files, click Delete files.

Deleting files may take some time, depending on the number of temporary files 
on your computer.

4. Click Close to close the Delete Browsing History window and click OK to close 
the Internet Options window.
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